& Guitar Rig

SESSION




Les informations contenues dans ce document peuvent étre modifiées a tout moment sans préavis
et n‘'engagent pas la responsabilité de Native Instruments GmbH. Le Logiciel décrit dans ce docu-
ment est soumis a I'acceptation d’'une Licence d’Utilisation et ne doit pas étre copié sur d’'autres
supports. Aucune partie de ce manuel ne peut étre copiée, reproduite, transférée ou enregistrée,
sous quelque forme que ce soit et pour quelque usage que ce soit, sans l'accord écrit explicite de
Native Instruments GmbH. Tous les noms de produits et d’entreprises sont des marques déposées
par leurs propriétaires respectifs.

Manuel d’utilisation écrit par: Alexander Stamm
Version du document : 1.0 (09/2009)
Version du produit : 4.0 (09/2009)

Remerciements spéciaux a I'équipe de béta-testeurs, dont I'aide nous fut précieuse non seulement
pour trouver et corriger les bogues, mais aussi pour rendre ce produit encore meilleur.



Germany

Native Instruments GmbH
Schlesische Str. 28
D-10997 Berlin

Germany
info@native-instruments.de

www.native-instruments.de

USA

Native Instruments North America, Inc.
5631 Hollywood Boulevard

Los Angeles, CA 90028

USA

sales@native-instruments.com

www.native-instruments.com

En NATIVE INSTRUMENTS

© Native Instruments GmbH, 2009. Tous droits réservés



Table des matieres

1 Bienvenue dans GUITAR RIG SESSION I..........oe s s e e e e s e e s s s e e e e e n e nnnnns 6
2 Avant de commencer — Remarques importantes..........uueeeeeeecciceeiiieerrresee e e e e e e e eeneas 7
2.1  Numéros de série et plaque SignaletiqUe.......cccceevirrrremmnirrrrrreerr e e nmnserreees 7
2.2 Utilisation du boitier en toute SECUNIte .......ceemmeeeeeiiiiiiiiirrrr e 7
2.2.1 AVEITISSEMENT et 7

2.2.2  RecomMMandationsS........ceuieiiii i e 8

2.2.3 Instructions pour le traitement des déchets ........coovviiiiiiiiiin, 9

2.3  Avis de non-responsabilité ... 9

3 LE BOITIER SESSION I/0......ucceeieecceereceesasesesesasseesssaeesesassssessssssessssssessssssssessnsassesssans 10
R T B S 111 - 11 I 17 T 1 10
K 1111 (=P 1T 1T 1= 3 - T SO 12

X TN o 1111 1= 11T T - 13

4 Installation sous Windows XP / Windows Vista...........cccmmiimmcccccccee e 14
4.1 Installation du [0GICIel......cceeueeiiiiiieeeiir s s e s e s s e s e e e s sn e s s s e e s e nmnsssasrrnnnnns 14
4.2 Installation du matériel ... 17
4.3  Configuration .......oceeeeeeeeecciee s e e e e e e e e e e e n s 20
4.3.1 Configuration de GUITAR RIG 4 ..., 20

4.3.2 Utiliser le SESSION 1I/0 comme interface audio par défaut ................... 22

4.4 Connexions audio et MIVEAUX.......cuueeeeeemmmmnnssssessererreesnnnnnssssssssssssseerssnsnnnnnnsnnsssssssees 24
441  Connecter votre instrument et ajuster le niveau d’entrée....................... 24

4.4.2 Connecter un second instrument.........c.cooiiiiiiiii 25

443 Leniveau dentrée de GUITARRIG 4. ..o, 26

444 Connecter 1a SOt ... 27

5 Installation sous Mac 0S X......cooieeeicmrcciiiiirr e e s s rrrsccssss s s s s s e e e s s s s s nnnnsssssssss e e e e e e e nnnnnmnnnnen 28
5.1 Installation du logiCiel.......ccoeeeeeieeii i 28
5.2 Installation du matériel ............. e 30

GUITAR RIG SESSION - IV



5.3  ConfigUuration .........cooiieeeeiiiiiiecers s s recesss s s s s snsss s e s s e nnsss s e s rnnnssssserrnnnssssssennnnnnsnnennns 31

5.3.1 Configuration de GUITAR RIG 4 ...ovenini e 31
5.3.2  Utiliser le SESSION I/0 comme interface audio par défaut ................... 32
5.4 Connexions audio et NIVEAUX...........cceeeerrremmmmmmmnssssssssserrrrrennnmssssssssssssssesessennnnnnnnnnes 33
5.4.1 Connecter votre instrument et ajuster le niveau d'entrée....................... 34
5.4.2 Connecter un second Instrument... ..o 35
5.4.3 Leniveau dentrée de GUITAR RIG 4...eeniniriiiieee e 36
5.4.4 Connecter [a SOrtie. ... 37
013 4211 P T 38
6.1  Problemes audio ........coooiieeeeccce e e e e e e e e e e e nnnnnnnnas 39
6.1.1 Pas de son ou volume faible ... 39
6.1.2  Signal distordu .....cooviniii 39
B.1.3 BrUIt coeiiii i 40
6.1.4  BoUCIES dE MASSE.....ieiiit i 40
6.2 Problemes liés au matériel .............coooiiiiecccccce e e 41
6.2.1 Problémes avec le pPilote ... 41
6.2.2 Problemes aveC 'USB ... 41
6.2.3  Utiliser le SESSION 1/0 avec un ordinateur portable ...............ccoceeeninin. 42
Spécifications TECHNIGUES ......cceeeeeeeeeciceei e e s s s e e e e e s e e e s ns s s s s s s s s s e e e e e e e e nnnnnnnnnes 44
78 T T 1= 3 44
1.2 Specifications aUMI0.......cceeeeemeeeeeiiiiiii s ennnnnnnanas 45
7.3 Alimentation GleCriQUE .......oeveeeeiiiiiric e r e e s e s s e s s e mn e e e s e nmn e e eens 48
7.4  Dimensions et Poids .......ccceveiiiiiiiiiiiiss s nnnne 48
1.5 Données environnementales ...........ccooeiiiiieeeccmccicsee s s e e e e e e e e e e e s e e e e e e e e e e nnnnnnnnas 49
7.6 Configuration FEQUISE .......cevrreeemeerirrrrneesisrerrrnssssssrrrsnnssssserrnnnssssssrsnnnsssssssnnnnnsssssnnns 49
71.6.1 Spécifications systeme gENErales .........coevvviviiiiiiiiiiiii e, 49
71.6.2  Formats de pilotes ErES ....ovuiriii i 49
71.6.3  Plateformes prises en charge........ccooiiiiiiiii i 49

GUITAR RIG SESSION -V



1 Bienvenue dans GUITAR RIG SESSION !

GUITAR RIG SESSION est la solution d’enregistrement parfaite pour les guitaristes, bassistes
et chanteurs. Elle est composée de deux produits : l'interface audio compacte GUITAR RIG
SESSION 1/0 et la version ESSENTIAL du logiciel de studio numérique de guitare GUITAR
RIG 4.

Le GUITAR RIG SESSION 1/0 est une interface audio de haute qualité optimisée pour |'uti-
lisation avec GUITAR RIG 4. Il s’agit d'une interface audio professionnelle intégrant un pré-
ampli microphone avec alimentation fantdbme et deux entrées que vous pouvez utiliser pour
brancher des guitares, des basses ou des sources de signal au niveau ligne. Une sortie ligne
a deux canaux se connecte a votre systeme d’amplification tandis qu’'un jack stéréo permet
un contrdle au casque a un volume indépendant.

Le boitier en métal compact et robuste est construit pour endurer toute les conditions, de
I'usage quotidien dans votre studio aux affres de la performance sur scene.

Dans les chapitres qui suivent, vous découvrirez les caractéristiques du GUITAR RIG SESSION
|/0 et comment en faire le meilleur usage. Veuillez lire ce manuel attentivement afin de vous
familiariser avec ce produit.
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2 Avant de commencer — Remarques importantes

Commencgons par le commencement ; avant d’utiliser le GUITAR RIG SESSION, nous vous
conseillons de lire ce chapitre attentivement.

2.1 Numeéros de série et plaque signalétique

GUITAR RIG SESSION posséde deux numéros de série. Le numéro de série du GUITAR RIG
SESSION 1/0 se trouve sur la face inférieure du boitier, accompagné de la plaque signalétique
indiquant le nom du modéle du produit ainsi que des informations techniques. Le numéro de
série permettant d'activer GUITAR RIG 4 se trouve sur la pochette du CD du produit.

2.2 Utilisation du boitier en toute sécurité

Veuillez lire attentivement les instructions qui suivent pour prévenir tout risque pour votre
santé et éviter d’'endommager le produit.

2.2.1 Avertissement

Pour prévenir toute atteinte a votre audition, veuillez systématiquement suivre ces importants
conseils de sécurité :

e Utilisé avec un amplificateur, un casque ou des enceintes actives, ce produit peut générer
des sons a des volumes susceptibles d’entrainer des |ésions auditives.

e Par précaution, réglez tous les volumes au minimum avant d’utiliser le GUITAR RIG SESSION
I/0. Augmentez progressivement les contréles de volume alors que la musique est en cours
de lecture pour ajuster le niveau d’écoute désiré.
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e Ne l'utilisez pas a un niveau élevé pendant des périodes trop longues. Si vous éprouvez des
problémes d’audition ou des sifflements dans les oreilles, consultez immédiatement un
médecin spécialiste de 'audition.

2.2.2 Recommandations

Pour vous assurer que le GUITAR RIG SESSION /0 ou tout autre matériel connecté a celui-ci
ne soit pas endommagé pendant son utilisation ou son entretien, il est important que vous
respectiez ces instructions :

® N'ouvrez pas I'appareil, ne tentez pas de le démonter ni de modifier en quoi que ce soit ses
composants internes. Lappareil ne contient pas d’éléments réparables par ['utilisateur. S'il
semble mal fonctionner, arrétez immédiatement de I'utiliser et faites-le vérifier par une per-
sonne qualifiée.

e N’exposez pas l'appareil a la pluie et ne 'utilisez pas prés de I'eau ni dans une atmosphére
trop humide.

e Empéchez tout liquide ou toute autre matiére de pénétrer dans I'appareil.

e N'utilisez et ne stockez jamais I'appareil dans des endroits a température élevée (p. ex. a la
lumiére du soleil dans un véhicule fermé, ou prés d’un radiateur...), ou sujets a de fortes
vibrations.

® Ne placez pas le GUITAR RIG SESSION I/0 en position instable dans laquelle il pourrait
tomber accidentellement. Avant de déplacer I'unité, débranchez tous les cables qui lui sont
connectés.

e Avant d’allumer ou d’éteindre un appareil quelconque, ramenez les niveaux de volume a
leurs minimums.

e N'exercez pas de pression démesurée sur les potentiometres ni sur les connecteurs.

e | orsque vous nettoyez le GUITAR RIG SESSION 1/0, utilisez un tissu doux et sec. N'utilisez
Jamais de diluant, solvant, liquide de nettoyage ni lingette de nettoyage imprégnée de pro-
duits chimiques.
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2.2.3 Instructions pour le traitement des déchets

Si le produit venait a étre définitivement endommagé, ou si vous désiriez vous en débarrasser,
veuillez observer la réglementation en vigueur dans votre pays concernant le traitement des
déchets électroniques.

2.3 Avis de non-responsabilité

Native Instruments GmbH ne peut étre tenue responsable des dégats ou des pertes de don-
nées occasionnés par une mauvaise utilisation ou une modification du GUITAR RIG SESSION
/0.

Les informations contenues dans ce manuel sont réputées correctes a la date d'impression
ou de mise en ligne. Cependant, Native Instruments se réserve le droit de modifier les spéci-
fications a tout moment et sans préavis ni obligation de mettre a jour les appareils existants.
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3 LE BOITIER SESSION 1/0

Ce chapitre vous présente le boitier SESSION 1/0.

3.1 Panneau avant

1 Lentrée micro (Mic) accepte les fiches XLR (symétriques). Elle permet de connecter votre
microphone au préamplificateur de I'Entrée 1 (Input 1) du boitier. Pour utiliser un micro
a condensateur, veuillez activer I'alimentation fantéme.

2 La prise de I'Entrée 1 (Input 1) (jack 6,35 mm, trois points (TRS) symétrique) peut re-
cevoir des signaux de niveau ligne ou instrument, selon la position de I'interrupteur Line/
Inst. Vous pouvez y brancher une guitare, une guitare basse, un clavier ou encore le canal
gauche d’'un appareil stéréo.

3 La prise de I'Entrée 2 (Input 2) (jack 6,35 mm, trois points (TRS) symétrique) peut re-
cevoir des signaux de niveau ligne ou instrument, selon la position de I'interrupteur Line/
Inst. Vous pouvez y brancher une guitare, une guitare basse, un clavier ou encore le canal
de droite d'un appareil stéréo.
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] Veuillez noter que cette entrée est prioritaire sur I'entrée XLR (1). Lorsqu’elle est utilisée,
. I'entrée XLR est désactivée.

Ce curseur contrdle le gain de I'lnput 1.
Ce curseur controle le gain de I'lnput 2.

Linterrupteur Inst/Line permet de régler la sensibilité des entrées Input 1 et Input 2.
Lorsque l'interrupteur est sorti, ces entrées conviendront a des signaux d’instruments tels
qu’une guitare ou une basse ; lorsqu’il est enfoncé, les entrées conviendront aux signaux
de niveau ligne. Le type d’entrée sélectionné est indiqué sur le dessus du boitier.

Ce curseur ajuste le niveau des sorties Output 1/2.
La prise casque vous permet de connecter votre casque stéréo.
Ce curseur ajuste le niveau de la sortie casque.
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3.2 Panneau supérieur

& GuitarRig session |'.-"'l=_'_= [m

1 Affiche le type de signal d’entrée sélectionné (Mic, Instrument, Line) pour I'lnput 1.
2 Cette diode indique la présence d’un signal a I'lnput 1 / Input 2.

3 Cette diode indique la saturation de I'lnput 1 / Input 2, il faut donc éviter qu’elle ne s’al-
lume lorsque vous jouez.

4 Affiche le type de signal d’entrée sélectionné (Instrument, Line) pour I'lnput 2.
9 Cette diode indique si l'alimentation fantdme est activée ou non.
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3.3 Panneau arriere

1 Ces prises transmettent le signal recu de votre ordinateur. Ces sorties trois points (TRS)
fonctionnent indifféremment avec des cables symétriques ou asymétriques. Assurez-vous
que les deux soient connectées pour avoir un son stéréo.

2 Ce port peut recevoir un cable verrou de sécurité compatible Kensington™. Utilisez-le
pour protéger votre module contre le vol.

3 Le port USB permet de connecter le boitier a votre ordinateur. Votre ordinateur doit gérer
la norme USB 2.0 pour fonctionner avec GUITAR RIG SESSION 1/0. Le boitier utilise
également I'alimentation du port USB pour fonctionner. Branchez directement le boitier
a un port USB 2.0 de votre ordinateur et évitez d’utiliser des hubs USB non alimentés.

4 Linterrupteur d’alimentation fantdme 48 V applique I'alimentation fantdme a I'entrée micro
XLR (1). Les micros a condensateur nécessitent I'utilisation d’'une alimentation fantéme,
tandis que les autres micros n’en ont pas besoin. Vérifiez bien que I'alimentation fantéme
est désactivée avant de connecter un microphone dynamique ou un microphone a ruban
afin d’éviter d’'endommager ce dernier.
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4 Installation sous Windows XP / Windows Vista

Ce chapitre décrit I'installation du boitier SESSION 1/0 sous Windows XP et Windows Vista.

Pour des informations détaillées sur le logiciel GUITAR RIG 4, veuillez consulter son manuel
de référence. Vous trouverez celui-ci sur le CD d’installation ainsi que dans le menu Help >
Open Manual > Francais dans GUITAR RIG 4.

4.1 Installation du logiciel

Assurez-vous d’'étre connecté(e) a votre ordinateur avec les droits d’administration. Ne connec-
tez pas encore le GUITAR RIG SESSION I/0.

1. Naviguez dans le contenu du CD et localisez le fichier d’installation. Il est intitulé « Guitar
Rig 4 Setup ». Si vous utilisez une version téléchargée de GUITAR RIG 4, il vous faut
d’abord décompresser les fichiers d’installation.

2. Double-cliquez sur le fichier « Guitar Rig 4 Setup » pour lancer la procédure d’installation.
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D Mative Instruments Guitar Rig 4 - Installiware Wizard E|§||g|

Welcome to the Native Instruments
Guitar Rig 4 Setup

Mote: &fter installation, do not move or rename the application
or the installation directory of the application, Otherwise, wou wil
nat be able ta run update installers,

Please make sure that the Guitar Rig 4 hardware is
not connected during this installation!

To conkinue, click Mext,

Mext = ] l Cancel

Suivez les instructions s’affichant a I'écran — elles vous guideront au cours de la procédure
d’installation du logiciel.

L'installeur vous demandera de spécifier le chemin d’acces au dossier de plug-ins de
votre DAW (Digital Audio Workstation, par exemple votre logiciel de séquencage). Si vous
comptez utiliser GUITAR RIG 4 uniqguement en mode autonome, ou Si vous ne savez pas
ce qu’est un plug-in, utilisez le réglage proposé par défaut.

l'installeur vous demandera si vous souhaitez installer les pilotes pour les interfaces audio
GUITAR RIG. Sélectionnez « SESSION /0 » puis cliquez sur « Continue ».

Au cours de l'installation du pilote, quelques message de sécurité Windows apparaissent,
du genre « Le pilote n’a pas été validé lors du test permettant d’obtenir le logo Windows »
ou bien « Windows ne peut Vvérifier I'identité du fabricant de ce pilote logiciel ». Ne
vous faites pas de souci, c’est tout a fait normal. Cliquez simplement sur « Continuer »
(Windows XP) ou sur « Installer » (Windows Vista) pour poursuivre I'installation.

GUITAR RIG SESSION - 15



Software Installation

' 'l_., The software you are installing has not passed Windows Logo
- testing to verfy its compatibility with Windows XP. (Tell me why
this testing is important.)

Continuing your installation of this software may impair
or destabilize the comect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the software vendor for software that has
passed Windows Logo testing.

Continue Amyway l [ STOP Installation

1. Une fois l'installation achevée, redémarrez votre ordinateur.

Les applications suivantes ont été placées sur votre disque dur :
e GUITAR RIG 4 - I'application autonome complete.

e Plug-ins GUITAR RIG 4 — utilisez GUITAR RIG 4 comme plug-in dans le séquenceur de votre
choix. Sur les ordinateurs Windows, GUITAR RIG 4 peut fonctionner en plug-in aux format
VST ou RTAS®.

e Service Center de Native Instruments — cette application gere I'activation des produits et
leurs mises a jour. Veuillez consultez le Guide d’Installation pour plus de détails.

® |es pilotes pour l'interface audio GUITAR RIG SESSION [/0.

Si vous n’avez encore jamais possédé de produit Native Instruments, il vous faudra vous en-

registrer en suivant les instructions a I'écran. Vous trouverez plus d’informations concernant
la création d’'un Compte Utilisateur NI et I'activation de GUITAR RIG 4 dans le Guide d’Installation
et le Manuel du Service Center, situés dans le dossier d’installation du Service Center.
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Si vous souhaitez installer uniqguement les pilotes de I'interface, un fichier installeur distinct
est disponible sur le CD d’installation. Vous pouvez également en télécharger la version la
plus récente depuis la section d’assistance du site web de Native Instruments.

4.2 Installation du matériel

Utilisez le cable USB fourni pour brancher le SESSION 1/0 a un port USB 2.0 de votre or-
dinateur.

Le SESSION 1/0 est alimenté via USB. Le fonctionnement n’est garanti qu’en périphérique
unique, sur un contréleur USB 2.0 ou sur un hub USB 2.0 auto-alimenté. Sur les systemes
Windows XP, le Service Pack 2 (ou ultérieur) est requis pour le bon fonctionnement du
SESSION I/0 — vous en saurez plus sur la version de votre systéme en ouvrant la fenétre
Propriétés Systeme.
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Systemn Hestore Automatic Updates Remate

General Computer Name

N
s

_ﬁ_'

Hardware Advanced

System:

Microsaft Windows XP
Professional

Wersion 2002

Service Pack 2

Feaistered to:

Dell Latitude D&30

Intel{R) Core{TM)2 Dua CPL
T9300 @ 2.50GHz

2 45GHz, 1.95 GB of RAM
Physical Address Bxtension

[ Support Infamation ]

| ok

H Cancel ]

Une fois le pilote correctement installé, le SESSION 1/0O est reconnu automatiquement. Si ce

n'est pas le cas, relancez l'installation du logiciel comme expliqué ci-dessus.

Plusieurs modules de pilotes sont alors assignés au SESSION 1/0, chacun d’eux entrainant
I’éclosion d’une fenétre pop-up qui vous demande comment vous souhaitez installer le nou-

veau périphérique.

1. Ne sélectionnez pas la connexion au site web Windows Update.

2. Choisissez « Installer le logiciel automatiquement » (Windows XP) ou « Localiser et ins-
taller les pilotes logiciels » (Windows Vista).

GUITAR RIG SESSION - 18



r

Found New Hardware Wizard

This wizard helps you install software for:

Sesgion [A0

\-j if your hardware came with an installation CD
2 orfloppy disk, insert it now.

What do you want the wizard to do?

'i?} Install the software automatically (Recommended)
() Ingtall from a list or specific location (Advanced)

Click Mest to continue.

< Back ][ Mead = ][ Cancel

3. Suivez les instructions a I'écran pour terminer cette procédure.

4. Lavertissement de sécurité de Windows apparait. Cliquez sur « Continuer » (Windows XP)
ou sur « Installer » (Windows Vista) pour installer proprement les pilotes.

Sur un ordinateur Windows, le pilote est associé a un port USB particulier. Si vous branchez
le cable USB sur un autre port que celui sur lequel le pilote a été installé, le processus d’assi-
gnation du pilote est relancé — si c’est le cas, suivez a nouveau les étapes décrites plus haut.

Si a un moment ou a un autre, I'ordinateur ne semble pas reconnaitre le SESSION /O, dé-
connectez le cable USB, attendez quelques secondes, puis reconnectez-le. Si le probleme
persiste, redémarrez votre ordinateur avec I'interface connectée.
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4.3 Configu

ration

Ce chapitre vous explique comment utiliser 'interface audio SESSION 1/0 sous Windows XP
/ Windows Vista, en particulier avec le logiciel GUITAR RIG 4. Nous supposons ici que vous
avez déja activé GUITAR RIG 4 via le Service Center — veuillez consulter le Guide d’Installation
pour de l'aide a ce sujet.

4.3.1 Configuration de GUITAR RIG 4

Nous allons maintenant configurer GUITAR RIG 4 pour utiliser I'interface SESSION 1/0. Veuillez
tout d'abord lancer le logiciel.

1. Lorsque le logiciel est lancé pour la premiére fois, la fenétre Audio Setup s'ouvre auto-
matiquement ; c’est la que vous devez effectuer les réglages suivants. Pour accéder a
ces réglages ultérieurement, sélectionnez File > Audio and MIDI Settings dans la barre
de menus de I'application.

Audio and MIDI Settings. ..

Routing MIDI (vl |

Audio

Driver [Asio -]
Device ( AsIO Config | [ Session 1/0 -]
Status Running
Sample Rate (44100 -]
Latency 88 Samples
Input » 2.5 ms Processing » 2.0 ms Qutput » 4.5 ms | Owverall » 9.0 ms

| £ Cancel | | % 0K |

2. Dans l'onglet « Audio », choisissez ASIO dans le menu « Driver ».

3. Sélectionnez I'entrée SESSION 1/0 dans le menu « Device ».
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Si le SESSION 1/0 n’apparait pas dans la liste, quelque chose ne va pas. Relancez l'installa-
tion comme expliqué ci-dessus.

Vous pouvez accéder au Control Panel (panneau de contrdle) du pilote en cliquant sur « ASIO
Config ». Dans le Control Panel du pilote, deux champs situés en bas de la fenétre indiquent
si le SESSION 1/0 est prét et s'il est connecté.

Oi Native Instruments Session 1/0 Control Panel g|§|@|

Soundcard Latency Settings

Presets: |minimal latency [low CPU usage sibuation] ﬂ

Thiz setting offers a minimunn output latency of ~8 me [3 ms input to
autput] but should only be uzed in zituations with low CPL uzage.

LISE Buffersize:; Audio Buffersize:

Buffer Format

Sample Hate: |44'IEIEIH2 -|

About

Ready connecked

'interface audio peut étre configurée via les parametres suivants :

® Presets : plusieurs presets pour les utilisations classiques sont proposés, de la latence mi-
nimale (pour les systemes puissants avec de gros processeurs) a des latences plus élevées,
mieux adaptées aux configurations moins rapides. Si vous étes habitué(e) aux réglages des
pilotes audio et souhaitez créer votre propre configuration, sélectionnez User Defined Settings
(cf. ci-dessous).

GUITAR RIG SESSION - 21



e USB Buffersize et Audio Buffersize (tailles des tampons USB et Audio) : ces paramétres
sont grisés sauf si User Defined Settings est sélectionné dans le menu Presets. Ces deux
parametres définissent la latence du systéme, c’est-a-dire le temps qui s’écoule entre la
réception d'un signal audio par le SESSION 1/0O et le moment ou vous entendez ce son dans
vos enceintes ou vos écouteurs. La taille du tampon audio (Audio Buffersize) doit toujours
étre au moins deux fois plus grande que celle du tampon USB (USB Buffersize). Veuillez
remarquer que la taille de Tampon USB affecte directement I'utilisation de CPU par le sys-
teme audio. Lutilisation du CPU varie d'un ordinateur a un autre ; n’hésitez pas a tester
différents réglages.

e Sample Rate (taux d’échantillonnage) : choisissez un taux d’échantillonnage compatible avec
votre logiciel audio et adapté a la puissance de votre ordinateur. Par défaut, le taux d’échan-
tillonnage est de 44100 Hz (qualité CD). Les taux d’échantillonnage plus élevés peuvent
améliorer la qualité audio, mais ils entrainent également plus de calculs pour le processeur.

Nous vous recommandons de sélectionner d’abord 'un des presets de latence proposés et
de poursuivre avec les autres étapes de la configuration. Une fois le tout achevé, revenez a
la fenétre Audio and MIDI Settings pour trouver le meilleur réglage de latence pour votre sys-
teme. Si des ruptures audio surviennent avec le réglage minimal latency, essayez low latency
ou standard latency. Les valeurs de latence plus élevées réduisent le risque de ruptures dans
I'audio.

4.3.2 Utiliser le SESSION 1/0 comme interface audio par défaut

Si vous souhaitez utiliser le SESSION 1/0 pour la lecture dans toutes vos applications audio
sur votre ordinateur (et non uniqguement pour vos logiciels de musique), vous devez le définir
comme interface audio par défaut.

Sous Windows XP, faites comme suit :
1.  Ouvrez Démarrer > Panneau de Configuration > Sons et Périphériques Audio.
2. Sélectionnez l'onglet « Audio ».

3. Dans les sections « Lecture Audio » et « Enregistrement Audio », cliquez sur le menu
Unité par Défaut et choisissez SESSION /0.

4. Cliquez sur OK pour fermer la fenétre « Sons et Périphériques Audio ».
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Sounds and Audio Devices Properties

Yalume Sounds Audio Vaice Hardwars

Sound playback
Default device:
4 Sezszian |0 Dutput W

Yolume... ] [ Advanced...

Sound recording

ﬁ Default device:
Sezzion [0 [nput o

MIDI music plavback

% Ciefault device:

22 | Microsoft GS Wavetable SW Syrith w

[ Volume... ] [ About... ]

[] Use only default devices

I oK H Cancel H Apply ]

Sous Windows Vista, faites comme suit :
1. Ouvrez Démarrer > Panneau de configuration > Matériel et audio > Son.
2. Sélectionnez l'onglet « Lecture ».

3. Dans la liste des périphériques, sélectionnez SESSION 1/0 puis cliquez sur « Définir par
défaut ».

4. Sélectionnez l'onglet « Enregistrement ».

9. Dans la liste des périphériques, sélectionnez SESSION 1/0 puis cliquez sur « Définir par
défaut ».

6. Cliquez sur OK pour fermer la boite de dialogue.
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4.4 Connexions audio et niveaux

Dans les sections qui suivent, vous apprendrez a connecter votre guitare et votre systeme
d’amplification au SESSION 1/0 ainsi qu’a régler correctement les niveaux d’amplification, du
cOté matériel comme du cété logiciel.

Veuillez lancer tout d’abord le logiciel GUITAR RIG 4.

4.4.1 Connecter votre instrument et ajuster le niveau d’entrée
1. Diminuez le volume sur votre systeme d’amplification afin d’éviter tout dommage auditif.

2. Vérifiez que le sélecteur d’entrée est placé sur « Instrument » (bouton relaché), sauf si
vous utilisez un préampli pour porter votre signal au niveau ligne.

3. Branchez le cable connecté a votre guitare ou basse dans 'une des entrées du SESSION
/0.

4. Diminuez complétement le volume du canal d’entrée que vous n'utilisez pas.

Ayez a l'esprit que, pour un instrument générant un signal stéréo (p.ex. un synthétiseur), vous
devez le connecter aux deux canaux d’entrée pour obtenir un son stéréo.
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Afin d’obtenir la meilleure qualité sonore, il convient d’avoir un signal suffisamment puissant ;
pour cela, il vous faut ajuster le niveau d’entrée du SESSION 1/0.

Les Input LED vous aident en vous indiquant visuellement le niveau du signal entrant sur
chaque canal :

Etat de la diode Signification

Diode éteinte Aucun signal en entrée
Diode allumée verte Signal entrant

Diode allumée rouge Signal entrant trop fort

Avant d’ajuster le gain d’entrée, montez le volume sur votre guitare. Grattez quelques cordes
avec le volume que vous comptez utiliser lors de I'enregistrement, et regardez I'lnput LED du
canal que vous utilisez :

1. Montez le niveau d’entrée correspondant jusqu’a ce que la diode de saturation commence
a s'allumer lorsque vous jouez.

2. Maintenant, tournez tres Iégerement le curseur en arriére, jusqu’a ce que la diode de
saturation ne s‘allume plus, méme quand vous jouez vraiment fort sur votre instrument.

La sensibilité d’entrée est maintenant réglée a son niveau optimal, permettant ainsi au
SESSION 1/0 de fournir la plus grande dynamique d’amplitude sans toutefois saturer.

4.4.2 Connecter un second instrument

Vous pouvez connecter des instruments différents aux canaux d’entrée tant qu'ils fournissent
tous les deux un signal au méme niveau (ligne ou instrument). Branchez simplement le cable
du second instrument dans la prise de l'autre entrée et ajustez son niveau d’entrée comme
indiqué dans la section précédente.
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Pour les instruments générant un signal stéréo, le second canal doit étre connecté pour avoir
un son stéreéo.

4.4.3 Le niveau d’entrée de GUITAR RIG 4

Nous supposons ici que votre guitare est connectée au SESSION 1/0 et que son niveau d’en-
trée est correctement réglé (cf. section 4.4.1). Nous devons maintenant nous assurer que le
signal d’entrée est traité a un niveau correct par le logiciel.

Jetez un il a I'en-téte de la fenétre de GUITAR RIG 4 : il contient le module d’entrée avec
le sélecteur de canal (L/R), une porte de bruit basique, le module de sortie avec un limiteur
et des informations sur la consommation de ressources processeur.

Pour une description et une explication détaillées du circuit de Réduction de Bruit, veuillez
consulter le Manuel de Référence de GUITAR RIG 4 inclus sur votre CD-ROM.

Notez que I'Input Meter affiche une certaine amplitude lorsque vous jouez. |l dispose égale-
ment d’'un réglage de volume intégré qui contrble le niveau d’entrée du logiciel. Ajustez-le de
maniére a obtenir le niveau le plus élevé possible sans que votre signal ne sature. Ceci est
indiqué par le Level Meter qui s'approche du rouge sans toutefois I'atteindre.

Si une seule guitare est connectée, GUITAR RIG 4 recoit un signal mono. Vous pouvez confi-
gurer le composant Input afin qu’il route le signal de votre guitare vers les deux canaux. Par
défaut, GUITAR RIG 4 est réglé pour traiter les deux canaux d’entrée (L et R sont activés),
et I'un des deux canaux d’entrée reste logiquement muet. Pour modifier ceci, cliquez sur le
bouton approprié (L ou R) a gauche de I'lnput Meter pour qu’un seul canal d’entrée soit actif.
Ceci routera le signal mono sur les deux canaux.
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4.4.4 Connecter la sortie

Le SESSION 1/0O fournit deux sorties mono (L/R) pour connecter votre systeme d’écoute, qu'il
s'agisse d'une console de mixage, d’une paire de moniteurs actifs ou de votre chaine hifi
stéréo. Ayez en téte que les deux sorties doivent étre connectées pour avoir un son stéréo.
Une sortie stéréo séparée (TRS) vous permet de connecter votre casque.

i use

=

— i —

®

1 Connectez les cables de sortie aux entrées de votre amplificateur, réglez le niveau de
sortie au minimum, allumez I'amplificateur et réglez son volume au niveau auquel vous
étes habitué(e).

2  Si vous utilisez un casque, connectez-le a la sortie et placez-le sur votre téte avec le
volume casque au minimum.

3 Rendez-vous dans le Preset Browser et sélectionnez un preset quelconque en cliquant
dessus. Commencez a jouer et augmentez avec précaution le volume de sortie ou le vo-
lume casque du SESSION 1/0 jusqu’au niveau souhaité.

Si votre instrument n’utilise gu’un seul canal, baissez complétement le curseur Gain de l'autre

canal.

Tout est prét, vous pouvez envoyer la sauce !

GUITAR RIG SESSION - 27



5 Installation sous Mac 0S X

Ce chapitre décrit I'installation de base du boitier SESSION 1/0 sous Mac OS.

Pour des informations détaillées sur le logiciel GUITAR RIG 4, veuillez consulter son manuel
de référence. Vous trouverez celui-ci sur le disque d’installation ainsi que dans le menu Help
> Open Manual > Francais dans GUITAR RIG 4.

9.1 Installation du logiciel

Assurez-vous d’étre connecté(e) a votre ordinateur avec les droits d’administration. Ne connec-
tez pas encore le SESSION 1/0.

1. Naviguez dans le contenu du CD et localisez le fichier « Guitar Rig 4 Installer ». Si vous
utilisez une version téléchargée de GUITAR RIG 4, vous devez d’abord décompresser le

fichier d’installation.
2. Double-cliquez sur le fichier de I'installeur pour démarrer la procédure d’installation.

00 « Install Guitar Rig 4

Welcome to the Guitar Rig 4 Installer

@ Introduction

Note: Afterinstallation, do not move or rename the
application or the installation directory of the
application. Otherwise, you will not be able to run
update installers.

(NIN

———
~ Continue
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3. Suivez les instructions s'affichant a I'écran — elles vous guideront au cours de la procédure
d’installation du logiciel.

4. Linstalleur vous demandera si vous souhaitez installer les pilotes pour les interfaces audio
GUITAR RIG. Sélectionnez « SESSION 1/0 » puis cliquez sur « Continue ».

5. Une fois l'installation achevée, redémarrez votre ordinateur.

Les applications suivantes sont placées sur votre disque dur :
e GUITAR RIG 4 - I'application autonome complete.

¢ Plug-ins GUITAR RIG 4 — utilisez GUITAR RIG 4 comme plug-in dans la station audio nu-
mérique de votre choix. Sur les ordinateurs fonctionnant sous Mac OS X, les formats VST,
AU et RTAS® sont gérés.

e Service Center de Native Instruments — cette application gere I'activation des produits et
leurs mises a jour. Veuillez consultez le Guide d’Installation pour plus de détails.

® |es pilotes pour l'interface audio SESSION 1/0.

Si vous n'avez encore jamais possédé de produit Native Instruments, il vous faudra vous

enregistrer en suivant les instructions a I'écran. Vous trouverez plus d’informations concernant
la création d’'un Compte Utilisateur NI et I'activation de GUITAR RIG 4 dans le Guide d’Installation et
le Manuel du Service Center, situés dans le dossier d’installation du Service Center.

Si vous souhaitez installer uniqguement les pilotes de I'interface, un fichier installeur distinct
est disponible sur le CD d’installation. Vous pouvez également en télécharger la version la
plus récente depuis la section d’assistance du site web de Native Instruments.
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5.2 Installation du matériel

Utilisez le cable USB fourni pour brancher le SESSION 1/0 a un port USB 2.0 de votre or-
dinateur.

Le SESSION 1/0 est alimenté via USB. Le fonctionnement n’est garanti qu’en périphérique
unique, sur un contréleur USB 2.0 ou sur un hub USB 2.0 auto-alimenté.

Une fois le pilote correctement installé, le SESSION 1/0 doit étre reconnu automatiquement.
Si a un moment ou a un autre, I'ordinateur ne semble pas reconnaitre le SESSION /O, dé-
connectez le cable USB, attendez quelques secondes, puis reconnectez-le. Si le probleme
persiste, redémarrez votre ordinateur avec I'interface connectée.
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9.3 Configuration

Ce chapitre vous expliqgue comment utiliser l'interface audio SESSION /0 sous Mac OS X,
en particulier avec le logiciel inclus GUITAR RIG 4. Nous supposons ici que vous avez déja
activé GUITAR RIG 4 via le Service Center — veuillez consulter le Guide d’Installation pour
de l'aide a ce sujet.

9.3.1 Configuration de GUITAR RIG 4

Nous allons maintenant configurer GUITAR RIG 4 pour utiliser I'interface SESSION 1/0. Veuillez

tout d'abord lancer le logiciel.

1. Lorsque le logiciel est lancé pour la premiére fois, la fenétre Audio Setup s'ouvre auto-
matiquement ; c’est la que vous devez effectuer les réglages suivants. Si vous voulez
accéder a ces réglages plus tard, sélectionnez GUITAR RIG 4 > Preferences dans le menu
du programme.

& Audio and MIDI Settings...

Audio Routing MIDI (")
Driver [ CoreAudio -
Device [ Session 1/0 (2 In, 2 Out) -
Status Running
Sample Rate (44100 -
Latency 512 Samples | [ ] )
Input » 16.0 ms | Processing » 11.6 ms | Output » 5.8 ms | Overall » 33.4 ms

(O cancel | [ @Ok |

2. Sur l'onglet Audio, choisissez CoreAudio dans le menu « Driver ».
3. Sélectionnez I'entrée SESSION 1/0 dans le menu « Device ».
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Si le SESSION 1/0 n’apparait pas dans la liste alors qu'il est connecté, quelque chose ne va
pas. Relancez I'installation telle que décrite a la section 5.1.

'interface audio peut étre configurée via les parametres suivants :

e Sample Rate (taux d’échantillonnage) : choisissez un taux d’échantillonnage compatible avec
votre logiciel audio et adapté a la puissance de votre ordinateur. Par défaut, le taux d’échan-
tillonnage est de 44100 Hz (qualité CD). Les taux d’échantillonnage plus élevés peuvent
améliorer la qualité audio, mais ils entrainent également plus de calculs pour le processeur.

e |atency : utilisez la tirette Latency pour régler la taille du tampon de I'interface audio, me-
surée en échantillons. Ceci a deux effets : plus le tampon audio est grand, plus la probabi-
lité de ruptures audio est faible. D'un autre c6té, la taille du tampon affecte directement la
latence globale (le délai) de votre systéme. Plus la latence est élevée, plus le temps entre
I'instant ou vous jouez une note et celui ou vous I'entendez est long.

Nous vous recommandons de commencer avec la taille de tampon par défaut, puis de conti-
nuer avec les autres étapes de la configuration. Une fois le tout achevé, chargez un preset
de base et revenez a la fenétre Audio and MIDI Settings pour trouver le meilleur réglage de
latence pour votre systéme. Ceci s’effectue en diminuant progressivement la taille du tam-
pon : glissez la tirette de latence vers la gauche tout en jouant quelque chose. Lorsque vous
commencez a entendre des craquements ou des ruptures, glissez lentement la tirette vers la
droite jusqu’a ce que ces artefacts aient entierement disparu.

9.3.2 Utiliser le SESSION 1/0 comme interface audio par défaut

Si vous souhaitez utiliser le SESSION 1/0 pour la lecture dans toutes vos applications audio
sur votre ordinateur (et non uniquement pour vos logiciels de musique), vous devez le définir
comme interface audio par défaut. Sous Mac OS X, faites comme suit :

1. Dans le Menu Pomme, choisissez Préférences Systeme.

2. Dans le Panneau qui s'ouvre alors, cliquez sur Son.
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600

Sound

Qutput volume:

| <] » || Show all (Q )
[ Sound Effects | Output  Input |
Choose an alert sound
| Name Type
Basso Built-in
Blow Built-in m
Bottle Built-in 1
Frog Built-in v |
Play alerts and sound effects through: ['Session /O | :l
Alert volume: * U *)))
I

1 1 1 1
M Play user interface sound effects
E Play feedback when volume is changed
E Play Front Row sound effects

)

o () : o)) M Mute

E Show volume in menu bar

3. Sur l'onglet Effets Sonores, sélectionnez SESSION 1/0 dans le menu « Emettre Alertes
et Effets Sonores via ».

pareil pour la sortie son ».

Cliquez sur l'onglet Sortie et sélectionnez SESSION I/0 dans la liste « Choisissez un ap-

9. Cliquez sur l'onglet Entrée et sélectionnez SESSION |/O dans la liste « Choisissez un
appareil pour I'entrée son ».

9.4 Connexions audio et niveaux

Dans les sections qui suivent, vous apprendrez a connecter votre guitare et votre systeme
d’amplification au SESSION 1/0 ainsi qu’a régler correctement les niveaux d’amplification, du
coté matériel comme du cété logiciel.

Veuillez lancer tout d’

abord le logiciel GUITAR RIG 4.
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9.4.1 Connecter votre instrument et ajuster le niveau d’entrée
1. Diminuez le volume sur votre systeme d’amplification afin d’éviter tout dommage auditif.

2. \Vérifiez que le sélecteur d’entrée est placé sur « Instrument » (bouton relaché), sauf si
vous utilisez un préampli pour porter votre signal au niveau ligne.

3. Branchez le cable connecté a votre guitare ou basse dans 'une des entrées du SESSION
/0.

4. Diminuez complétement le volume du canal d’entrée que vous n’utilisez pas.

Ayez a I'esprit que, pour un instrument générant un signal stéréo (p.ex. un synthétiseur), vous
devez le connecter aux deux canaux d’entrée pour obtenir un son stéréo.

a @ Te e
| 2 7] | 1)

Afin d’obtenir la meilleure qualité sonore, il convient d’avoir un signal suffisamment puissant ;
pour cela, il vous faut ajuster le niveau d’entrée du SESSION 1/0.
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Les Input LED vous aident en vous indiquant visuellement le niveau du signal entrant sur
chaque canal :

Etat de la diode Signification

Diode éteinte Aucun signal en entrée
Diode allumée verte Signal entrant

Diode allumée rouge Signal entrant trop fort

Avant d’ajuster le gain d’entrée, montez le volume sur votre guitare. Grattez quelques cordes
avec le volume que vous comptez utiliser lors de I'enregistrement, et regardez I'lnput LED du
canal que vous utilisez :

1. Montez le niveau d’entrée correspondant jusqu’a ce que la diode de saturation commence
a s'allumer lorsque vous jouez.

2. Maintenant, tournez tres |égérement le curseur en arriere, jusqu’a ce que la diode de
saturation ne s’allume plus, méme quand vous jouez vraiment fort sur votre instrument.

La sensibilité d’entrée est maintenant réglée a son niveau optimal, permettant ainsi au
SESSION 1/0 de fournir la plus grande dynamique d’amplitude sans toutefois saturer.

5.4.2 Connecter un second instrument

Vous pouvez connecter des instruments différents aux canaux d’entrée tant qu'ils fournissent
tous les deux un signal au méme niveau (ligne ou instrument). Branchez simplement le cable
du second instrument dans la prise de l'autre entrée et ajustez son niveau d’entrée comme
indiqué dans la section précédente.

Pour les instruments générant un signal stéréo, le second canal doit étre connecté pour avoir
un son stéréo.
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5.4.3 Le niveau d’entrée de GUITAR RIG 4

Nous supposons ici que votre guitare est connectée au GUITAR RIG SESSION 1/0 et que
son niveau d’entrée est correctement réglé (cf. section 4.4.1). Nous devons maintenant nous
assurer que le signal d’entrée est traité a un niveau correct par le logiciel.

Jetez un il a I'en-téte de la fenétre de GUITAR RIG 4 : il contient le module d’entrée avec
le sélecteur de canal (L/R), une porte de bruit basique, le module de sortie avec un limiteur
et des informations sur la consommation de ressources processeur.

Pour une description et une explication détaillées du circuit de Réduction de Bruit, veuillez
consulter le Manuel de Référence de GUITAR RIG 4 inclus sur votre CD-ROM.

Notez que I'Input Meter affiche une certaine amplitude lorsque vous jouez. |l dispose égale-
ment d’'un réglage de volume intégré qui controle le niveau d’entrée du logiciel. Ajustez-le de
maniére a obtenir le niveau le plus élevé possible sans que votre signal ne sature. Ceci est
indiqué par le Level Meter qui s'approche du rouge sans toutefois I'atteindre.

Si une seule guitare est connectée, GUITAR RIG 4 recoit un signal mono. Vous pouvez confi-
gurer le composant Input afin qu’il route le signal de votre guitare vers les deux canaux. Par
défaut, GUITAR RIG 4 est réglé pour traiter les deux canaux d’entrée (L et R sont activés),
et I'un des deux canaux d’entrée reste logiquement muet. Pour modifier ceci, cliquez sur le
bouton approprié (L ou R) a gauche de I'Input Meter pour qu’un seul canal d’entrée soit actif.
Ceci routera le signal mono sur les deux canaux.
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5.4.4 Connecter la sortie

Le SESSION 1/0O fournit deux sorties mono (L/R) pour connecter votre systeme d’écoute, qu'il
s'agisse d'une console de mixage, d’une paire de moniteurs actifs ou de votre chaine hifi
stéréo. Ayez en téte que les deux sorties doivent étre connectées pour avoir un son stéréo.
Une sortie stéréo séparée (TRS) vous permet de connecter votre casque.

i use ( 48V

=

®

1. Connectez les cables de sortie aux entrées de votre amplificateur, réglez le niveau de

sortie au minimum, allumez I'amplificateur et réglez son volume au niveau auquel vous
étes habitué(e).

2. Sivous utilisez un casque, connectez-le a la sortie et placez-le sur votre téte avec le vo-
lume casque au minimum.

3. Rendez-vous dans le Preset Browser et sélectionnez un preset quelconque en cliquant
dessus. Commencez a jouer et augmentez avec précaution le volume de sortie ou le vo-
lume casque du SESSION 1/0 jusqu’au niveau souhaité.

Si votre instrument n’utilise qu'un seul canal, baissez compléetement le curseur Gain de
I'autre canal.

Tout est prét, vous pouvez envoyer la sauce !
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6 Depannage

Si vous rencontrez un quelconque probleme avec votre matériel, nous vous recommandons de
suivre ces quelques étapes pour trouver la solution avant de contacter I'équipe d’assistance
technique :

® Rendez-vous sur la Base de Connaissances (Knowledge Base) en ligne de NI. Le moyen le
plus simple de la trouver est de sélectionner Help > Visit the Knowledgebase... dans le menu
de GUITAR RIG 4.

® Rendez-vous sur le User Forum (forum des utilisateurs) sur le site web de NI (http://www.
native-instruments.com/forum/) et effectuez une recherche pour trouver les réponses éven-
tuelles de la communauté d'utilisateurs et utilisatrices de GUITAR RIG.

Lorsque vous prenez contact avec I'équipe d’assistance technique (Technical Support), vé-
rifiez que vous avez a portée de main toutes les informations nécessaires concernant votre
ordinateur. Pour les informations sur la version du pilote et la révision du microprogramme
(firmware), veuillez regarder dans le Driver Control Panel.

e Sur les ordinateurs Windows, vous trouverez ce dernier dans le dossier GUITAR RIG 4 du
menu Démarrer. Ces informations sont affichées lorsque vous cliquez sur « About ».

e Sous Mac OS X, vous pouvez accéder au Driver Control Panel depuis les Préférences
Systeme. Les informations sont affichées dans la fenétre principale.

Pour contacter I'équipe d’assistance, veuillez vous rendre a cette URL :
http://www.native-instruments.com/support/

Pendant leur phase de développement, tous les produits Native Instruments sont testés de
maniére extensive dans des situations réelles. Néanmoins, si votre produit doit étre renvoyé,
I’équipe d’Assistance Technique (Technical Support) vous fournira un numéro RA (Return
Authorization, Autorisation de Retour) pour accélérer le processus de retour. Veuillez contacter
notre équipe d’Assistance Technique avant de renvoyer un quelconque produit. Les paquets
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renvoyés sans ce numéro RA ne pourront étre correctement identifiés, et risquent ainsi de ne
pas étre pris en charge efficacement.

6.1 Problemes audio

Cette section vous propose de l'aide pour les problemes audio les plus courants.

6.1.1 Pas de son ou volume faible
Si votre sortie audio est muette ou faible, différentes causes sont possibles :
e (Cables débranchés ou défectueux. Veuillez vérifier tous les branchements et tous les cables.

e Mauvaise carte son ou entrée audio sélectionnée. Veuillez sélectionner I'entrée Audio and
MIDI Settings dans le menu de GUITAR RIG 4 et vérifier si le pilote SESSION 1/0O est bien
sélectionné dans la fenétre qui s’ouvre.

e Mauvais canal choisi dans le module Input de GUITAR RIG 4. Connectez votre instrument
a l'autre entrée, ou bien passez a l'autre canal en choisissant « L » dans le composant
INPUT.

e |e Gain d'Entrée du SESSION 1/0O est réglé trop bas. Augmentez le niveau d’entrée corres-
pondant.

e | e potentiométre de volume de votre instrument est réglé a un niveau trop faible. Tournez-
le pour augmenter le volume.

6.1.2 Signal distordu

Si le signal audio semble étre distordu alors qu’aucune distorsion n’est ajoutée par le logiciel
GUITAR RIG 4, il est probable que le gain d’entrée du SESSION 1/0 soit trop élevé. Réduisez
I'Input Level sur I'interface pour empécher la saturation du préamplificateur. Si votre instru-
ment produit un signal de niveau si fort que le préampli sature toujours, réduisez le volume
directement sur votre guitare. Généralement, ceci ne se produit que si I'instrument est équipé
d’'une électronique active et de micros (pickups) spéciaux a sortie haute puissance.
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6.1.3 Bruit

Un bourdonnement audible peut avoir plusieurs origines, dont certaines sont détaillées ci-
dessous :

® |es micros a simple bobinage sont sensibles aux interférences électriques. Les micros a
double bobinage (humbuckers) produisent beaucoup moins de bruit, d’ot leur nom (de
« hum » = « bourdonnement » et « to buck » = « réduire »...).

e \otre guitare est placée trop prés d’'un équipement électrique. Pour réduire ce type de
bourdonnement, éloignez la guitare de I'équipement électrique en question.

e |e potentiometre de volume de la guitare est a un niveau trop faible. Tournez-le pour aug-
menter le volume. Si votre guitare posséde plusieurs boutons de volume, assurez-vous de
les avoir tous vérifiés.

e Vous utilisez un cable pour guitare défectueux ou non blindé. Il est méme possible que le
blindage de votre guitare elle-méme soit inadéquat. Commencez par essayer de remplacer
votre cable de guitare par un modéle blindé. Si cela n’arrange rien, il vous faudra peut-étre
faire réviser |'électronique et le blindage de votre guitare par un spécialiste.

Si vous entendez des sifflements, le niveau a I'entrée du préamplificateur du SESSION 1/0
est peut-étre trop faible. Montez le volume de votre instrument ou augmentez le niveau d’en-
trée sur le SESSION 1/0. Pour plus d’informations concernant le réglage du niveau d’entrée,
veuillez vous reporter a la section 4.4 (Windows XP / Windows Vista) ou a la section 5.4 (Mac
0S X) de ce manuel.

6.1.4 Boucles de masse

Les boucles de masse (généralement percues comme un bourdonnement ou un grésillement)
constituent un probléme classique lorsque de multiples appareils électriques sont connectés
au méme circuit alimentation. Les étapes suivantes devraient vous aider a éliminer la boucle
de masse :

e Débranchez tous les appareils que vous n’utilisez pas actuellement, notamment les périphé-
riques externes de votre ordinateur (disques durs externes, graveurs de CD, etc.).
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e Branchez un boitier de direct (DI Box) derriére les sorties du SESSION 1/0. La plupart de
ces boitiers disposent d'un interrupteur « ground lift » qui vous permet de briser la boucle
de masse et d’éliminer le bruit.

6.2 Problemes liés au matériel

Vérifiez régulierement sur le site web de Native Instruments et via le Service Center de NI Ia
présence éventuelle de mises a jour pour le pilote du SESSION /O et d’autres informations
utiles.

6.2.1 Prohlemes avec le pilote

Assurez-vous que le boitier du SESSION 1/0 est connecté a 'ordinateur, et ouvrez le Driver
Control Panel. Lisez l'introduction de ce chapitre pour savoir comment trouver le Control Panel.

Si le Driver Control Panel est absent, le pilote n'est probablement pas installé du tout. Dans
ce cas, veuillez réinstaller le pilote comme décrit plus haut.

Si tous les menus déroulants du Control Panel sont grisés, le SESSION 1/0 n’est pas reconnu
par le pilote. Il doit y avoir quelque chose d’anormal dans la connexion USB ; lisez les sections
suivantes pour plus de détails.

6.2.2 Problemes avec I'USB

Le SESSION /0 est une interface USB 2.0 et ne fonctionnera pas sur un port USB 1.0/1.1.
Connectez-la toujours directement a un port USB 2.0 de votre ordinateur. Le port doit satisfaire
aux spécifications USB 2.0, notamment celles relatives a I'alimentation disponible (500 mA).
Sur certains ordinateurs, les ports USB 2.0 ne satisfont pas aux spécifications officielles de
la norme USB 2.0. Si vous étes dans ce cas, vous verrez peut-étre apparaitre un message
vous indiquant que l'alimentation est insuffisante pour faire fonctionner votre appareil. Le
SESSION /0 peut alors produire des craquements, voire méme ne pas fonctionner du tout.
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e Si votre ordinateur ne peut pas fournir la puissance électrique nécessaire via USB, essayez
de brancher le SESSION 1/0 sur un hub USB 2.0 avec une alimentation externe. Evitez de
connecter d’autres appareils au hub, car tout périphérique alimenté par le hub diminuerait
la puissance électrique disponible.

® En cas d'échec, il est toujours utile de vérifier si le SESSION 1/0O fonctionne lorsque vous
déconnectez tous les appareils USB de votre ordinateur, a I'exception de votre clavier et de
votre souris.

e Sivous rencontrez des problemes de ruptures dans I'audio ou d’autres problémes en relation
avec la connexion USB, branchez le SESSION 1/0 sur un autre port USB 2.0.

e Un mauvais cable USB peut étre responsable de ruptures dans I'audio et/ou d’autres pro-
blémes de connexion. Essayez avec un autre cable comportant le symbole officiel USB,
parfois I'utilisation d’un cable plus court peut résoudre le probleme.

e Sjvotre SESSION 1/0 plante ou fonctionne mal sur une machine Windows, la premiére chose
a faire est de désactiver la gestion de 'alimentation des contrbleurs USB, activée par défaut.
Ouvrez le Gestionnaire de Périphériques (Panneau de Configuration > Systeme > Matériel),
et effectuez un clic droit sur un hub USB afin d’en ouvrir les propriétés. Sur I'onglet « Gestion
de l'alimentation », décochez toutes les cases. Recommencez pour chaque hub USB et
redémarrez I'ordinateur.

6.2.3 Utiliser le SESSION 1/0 avec un ordinateur portable

Veuillez vérifier que votre ordinateur est capable de gérer le traitement audio en temps réel
sans rupture. |l existe quelques logiciels gratuits permettant d’analyser votre systéme, par
exemple :

www.thesycon.de/deu/latency_check.shtml

Lancez ce logiciel avec le SESSION 1/0O déconnecté. Au cas ou votre ordinateur n'est pas
capable de gérer correctement un traitement audio en temps réel, 'outil affiche des barres
de latence rouges et reporte cette information dans la partie basse de la fenétre.

De maniére générale, il n'est pas recommandé d’utiliser un ordinateur portable avec une carte
graphique a mémoire partagée. Votre projet audio a besoin de toute la mémoire et de toute
la puissance de calcul disponibles !
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Voici quelques étapes permettant d’optimiser les performances audio de votre ordinateur
portable :

e || est recommandé de ne pas faire fonctionner votre ordinateur portable sur sa batterie, car
il est probable que la gestion de I'alimentation diminue automatiquement la fréquence d’hor-
loge du processeur pour économiser de la batterie.

® Déconnectez tous les périphériques inutilisés (imprimante, scanner...). Ceci augmentera la
puissance processeur disponible pour votre logiciel audio.

e |es ordinateurs portables sont souvent équipés de périphériques internes qui perturbent le
traitement audio, comme par exemple une carte réseau ou une carte sans-fil. Il vous faudra
peut-&tre désactiver ces périphériques lorsque vous travaillerez avec le GUITAR RIG SESSION
/0.
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1 Specifications Techniques

Ce chapitre contient toutes les spécifications techniques concernant l'interface matérielle
SESSION 1/0.

1.1 Connexions

e 2 entrées jack (In 1, In 2) pour fiches jack mono de 6,35 mm (1/4")

e 2 sorties jack (Out 1, Out 2) pour fiches jack 6,35 mm (1/4”’) mono asymétriques ou TRS
(trois points pointe/anneau/base) symétriques

e 1 sortie jack Casque pour fiche jack 6,35 mm (1/4"") stéréo
e 1 fiche USB 2.0 de Type B
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1.2 Spécifications audio

Entrées Audio (Analogique/Numeérique)

Canaux

Fréquence d’échantillonnage

441 - 48 - 88,2 - 96 — 192 kHz

Résolution numérique

16, 24 Bit

Convertisseur

Cirrus Logic

Entrée Micro

Impédance d’entrée

4,8 kQ symétrique

Niveau Full Scale (gain max) -46 dBu
Niveau d’entrée maximal O dBu
Taux de distorsion harmonique (THD + N)[ 0,008 %

Réponse fréquentielle

10 - 40000 Hz (-1 dB)
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Entrée ligne

Impédance d’entrée

44 kQ asymétrique et symétrique

Niveau Full Scale (gain max)

-2,19 dBu

Niveau d’entrée maximal

+15 dB asymétrique et symétrique

Rapport Signal sur Bruit (pondéré)

96,2 dB

Taux de distorsion harmonique (THD + N)

0,008 %

Réponse fréquentielle

10 - 40000 Hz (-1 dB)

Entrées instrument

Impédance d’entrée

1 MQ asymétrique

Niveau Full Scale (gain max)

-8,3 dBu

Niveau d’entrée maximal

+9 dB asymétrique

Rapport Signal sur Bruit (pondéré)

95,9 dB

Taux de distorsion harmonique (THD + N)

0,008 %

Réponse fréquentielle

10 - 40000 Hz (-1 dB)
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Sorties Audio (Numérique/Analogique)

Canaux

Fréquence d’échantillonnage

441 - 48 - 88,2 - 96 — 192 kHz

Résolution numérique

16, 24 Bit

Convertisseur

Cirrus Logic

Sorties ligne

Impédance de sortie

100 Q asymétrique, 200 Q2 symétrique

Niveau maximal de sortie +6 dBu
Rapport Signal sur Bruit (pondéré) 100 dBu
Taux de distorsion harmonique (THD + N)| 0,008 %

Réponse fréquentielle

10 - 45000 Hz (-0,5 dB)
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Sortie casque

Impédance de charge 8 — 600 ohms
Niveau maximal de sortie 1,67 V eff a 100 ohms
Rapport Signal sur Bruit (pondéré) 98,2 dB

Taux de Distortion Harmonique (THD+N) [ 0,008 %
(@ 60 Ohms)

Réponse fréquentielle 10 — 40000 Hz (-1 dB)

1.3 Alimentation électrique

Via l'interface USB 2.0, 5V - 500 mA

'appareil n'a pas besoin d’alimentation électrique séparée ni de batterie, I'alimentation est
fournie par le port USB. Cependant, le fonctionnement du SESSION 1/0 n’est garanti qu’en
périphérique unique, sur un contrdleur USB 2.0 ou sur un hub USB 2.0 auto-alimenté.

1.4 Dimensions et poids

121 x 115 x40 mm (4,76 x 4,53 x 1,57 pouces)
0,56 kg (1,235 livres)
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1.5 Données environnementales

Température de fonctionnement : de O a 40 °C (humidité inférieure a 85 %)

Température de stockage : de -20 a 50 °C (humidité inférieure a 85 %)

1.6 Configuration requise

1.6.1 Spécifications systéme générales

e Windows® XP Service Pack 2 ou Windows® Vista™ (32/64 bit), Intel® Pentium™ ou
AMD® Athlon™ XP 1.4 GHz, 1 Go RAM, USB 2.0

e Mac OS® X 10.5, Intel® Core™ Duo 1,66 GHz, 1 Go RAM, USB 2.0

1.6.2 Formats de pilotes gérés
e Mac OS® X: Core Audio™
e Windows® : ASIO® (recommandé), DirectSound™, WASAPI™

1.6.3 Plateformes prises en charge
® Mac OS® X : application autonome, VST®, Audio Units™, RTAS® (Pro Tools 7/8)
e Windows® : application autonome, VST®, RTAS® (Pro Tools 7/8)
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